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eTutorial to Intermediate Excel 

 

This section of the eTutorial will expand your ability to manipulate data by 
introducing you to some  of Microsoft Excel’s more advanced features. 
Because there are so many ways to use some of these features, not every 
example will have a Try It! example.  

How do I find averages?   
Finding averages is much like finding sums. When Excel averages numbers, it 
adds all the numbers in the range you select together and divides them by 
the number of cells in that range—except those cells that are empty!  

To find the average of a range of numbers, do the following:  

• Select the cell where you would like the average to appear and type 
“=average(“  

• Without typing any other characters 
or pressing Enter, use your mouse 
to select the range of cells you wish 
to average (Hint: If you would like 
to select cells that are not adjacent 
to each other, hold down the CTRL 
key as you select them)  

• When you have selected all of the cells you want to average, type “)”—
the closing parenthesis— and press Enter  

The average of the cells you selected should 
appear. Keep in mind, Excel will only average 
those cells which have a numeric value! If one 
of the cells in the range is empty, or contains 
text rather than a number, Excel will ignore 
that cell when figuring the average.  

How do I find the largest or smallest number in a 
range?  
Sometimes, especially in large worksheets, you may want to find the largest 
or smallest number in a range of cells. For instance, you may want to know 
the greatest amount of time spent on any project in one month or the least 
amount of money spent on heating bills in one week.  

To find the largest or smallest numbers in a range, use the MIN and MAX 
features:  
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• Select the cell where you would like the minimum or maximum value 
to appear and type “=min(“ (to find the lowest number) or “=max(“ 
(to find the highest number)  

• Without typing any other characters or pressing Enter, use your 
mouse to select the range of cells you wish to average (Hint: If you 
would like to select cells that are not adjacent to each other, hold 
down the CTRL key as you select them)  

• When you have selected all of the cells you want to average, type “)”—
the closing parenthesis— and press Enter  

• The minimum or maximum value of the cells you selected should 
appear  

How do I make a chart?  
Looking at a mass of numbers can sometimes be 
confusing.  For that reason, many people feel it is 
helpful to display your information in the form of 
a chart. Because we tend to absorb data more 
quickly in graphic format than as raw numbers, 
charts allow us to communicate worksheet 
information in a more efficient way. They also add 
color and variety to otherwise dry financial and 
statistical reports.  

Excel is able to display your information as a number of charts, but this 
Lesson focuses on two of the most common: column charts and line charts.  

Column charts are good at comparing information in different categories. 
For instance, if Elmer’s Bike Store wanted to show that it was selling 
dramatically more race bikes than mountain or road bikes, it might use a 
column chart like the one shown here.  

A line chart is good at showing 
how information changes over time. 
If Elmer’s Bike Shop wanted to 
show how sales of its three main 
types of bikes changed from 
January to April, the owner might 
use a line chart.   

To turn data into a column or line 
chart, do the following:  

• Select the cells that have the information you want to include in the 
chart—be sure to include the title of your worksheet  

• Click the Chart Wizard button  

• A new dialog box will appear with   several 
chart types for you to pick from  
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• Click either Column or Line from the left side of the dialog box (for a 
basic chart, do not choose a subcategory, but feel free to experiment 
with these later)  

• To see a sample of how your data will appear before inserting the 
chart, click and hold the button Press and Hold to View Sample  

• Click Finish  

Once you have created a chart, you can move it by clicking the box around it 
and dragging it to a new location. You can also click and drag the black boxes 
along the sides to alter the chart’s size.  

Hint: If you use blank lines or rows to create extra space in your chart, you 
will want to exclude them from your data range. This sounds confusing but 
there’s an easy way to do this. Instead of clicking and dragging over a whole 
range of cells to select all the cells in that range, you can simply choose 
some of them.  

• First, select the first range you want to include in your chart  

• Press and hold the CTRL key and select the next range of cells you 
want to include in your chart  

This allows you to skip over any blank lines! If you want a fancy term for 
this, you can call it selecting non-contiguous cells.  

  

When you are done, if you are doing a chart for a budget, you should see 
something like this:  
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How do I search for data or automatically replace it?   
Excel contains a Find/Replace function similar to the tool you are familiar 
with from Word and PowerPoint, and you can use it to search for words, 
numbers, or formulas.  

• To start a Find, from the Edit menu, click Find or press CTRL+F  

There are a few differences in the way Excel’s Find function works. For 
instance, in Excel, you can search by rows (moving across the worksheet 
from A toward Z and then down) or search by columns (moving down each 
column and then across the worksheet). Also, you have to tell the program 
the type of cell you want it to look in: formulas (all cells that perform 
calculations or whose contents begin with =), data values (all other cells), or 
comments (which we will not cover here). A single Find request will not 
search all cells. 

Two other options are:  

• “Match Case” tells 
the program to 
look only for data 
capitalized 
exactly like the 
target text. 
Needless to say, 
this is only useful 
when working 
with non-
numerical data.  

• “Find Entire Cells Only” tells the program to look only for cells whose 
contents exactly match the target text, number, or formula: no more, 
no less.  

The Replace function will search all cells for a particular value and replace it 
with another value. For instance, if you want to change all SUM formulas to 
AVERAGE formulas, you could use this feature.  

How do I see two areas of a large worksheet?  
Sometimes, you will want to look closely at two areas on one worksheet, but 
they both won’t easily fit on your computer monitor.  

In order to help you see as much as you can at once, Excel allows you to 
break your worksheet into two screens by using the split bars. Once you 
have divided the worksheet into two screens, you can scroll each screen to a 
different part of the worksheet. So instead of this:  
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You see this:  

To use 
your 
Excel 
split bar, 

simply look to the side 
of your window for the 
scroll bars. There you 
should see a small box called the split box. You can click and drag the split 
box in order to create a split bar to break your screen up horizontally or 
vertically.  

How do I write an if-then formula?  
Sometimes, you will want to vary the type of information in a cell based on 
the contents of another cell.  

For instance, if you wanted to keep track of total costs on a project on which 
several independent contractors were working, you could create a 
spreadsheet formula that entered the amount you were paying them as soon 
as they completed their portion of the work.  

To use an IF formula, do the following:  

• Select the cell where you would like the 
results of the formula to appear  

• Type “=if(“  

• Then enter the logical test for your 
formula, followed by the result if true, 
then the result if false, followed by a closing parenthesis  
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How do I use Excel’s goal-seeking feature?  
Sometimes you know what you would like the result of a formula to be… For 
instance, you might know how much you want to change each month, but 
might not understand what you need to cut back on to make that change.  

For instance, let’s say you have set aside $300 each month for your own 
personal enjoyment, but you want to save some of this money for a big 
vacation you are taking later this year. In order to save more for the 
vacation, you will want to spend less on eating out and other entertainments, 
but how much do you need to cut back if you want to make sure you save at 
least $120 each month? How much should you cut back if you want to make 

sure you save at least $150 each 
month?  

Once you have set up a personal 
budget that looks something like 
this one, you can use Excel’s goal 
seeking feature to find out where to 
make the cut-backs.  

First, select the cell with the 
formula for which you’d like to set 
the final value—in this case, cell 

D24 (which adds cells D18 and D19 and subtracts the total from $300), then 
do the following:   

• From the Tools menu, click Goal Seek…  

• In the new dialog box, enter what the 
result of the formula should be in the To 
value field  

• In the By changing cell field, tell the 
program the cell it will have to change to 
attain this goal (in our example, decide 
whether you’d like to cut back on eating out or general entertainment)  

• Click OK  

Excel will automatically try to solve your problem by finding a new value for 
the cell you told it to change. If it can find a way to make your goal work, it 
will make the change then ask if you would like to accept or reject it. Take a 
look at the cell you wanted to change (in our case D19) to make sure the 
solution it came up with will actually work!  
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To accept the new values, press OK. Otherwise, press Cancel.  

How do I identify problem cells or formulas?  
If you fill out a formula incorrectly, Excel will give you an error message. All 
error messages are in all caps and are preceded by a number sign. Two of 
the most common error messages are:  

#REF?  Your formula refers to a cell that does not exist or does not have a 
valid value.  

#NAME? Your formula has text in it that Excel does 
not recognize.  

When you receive and error in Excel, you will see a 
small box with an exclamation point pop up next to 
the cell that contains the problem formula. Clicking on 
this box will provide you with a menu that will help 
you understand what caused the error and figure out how to fix it.  

How do I import information into excel?  
Excel can import information from tables on Web pages or from online 
datasets, which prevent you from having to retype the information!  

The Internet is full of information that you might want to import into your 
own Excel worksheet. For instance, if you are building a time management 
schedule in Excel, you might want to pull your work hours from your 
company’s online duty roster, or, if you are preparing for a major purchase, 
you might want to download a comparison of several products from a 
consumer website. Also, you might want to download stock quotes or budget 
information from a finance website.  

To import stock quote information into one of your spreadsheets, try the 
following:  

• Make sure you are logged in to the Internet  

• Select the cell where you would like to import the data  

• From the Data menu, click Import External Data then Import Data  
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• From the list of available data sources, click the one you would like to 
use (most likely, MSN MoneyCentral Investor Stock Quotes)  

• Click Open  

• Click OK  

• Enter the stock or fund symbols of the companies or funds you want 
information from  

In addition to stock quotes, Excel allows you to import stock market index 
levels like the Dow Jones Industrial Average (use data source MSN 
MoneyCentral Investor Major Indices) and foreign currency values (use data 
source MSN MoneyCentral Investor Currency Rates). Many companies also 
create their own specialized queries to help you import the kind of 
information you’ll need.  

If you would like to import information from another online source (you can 
import anything on the Web that appears in a table!), you can choose New 
Web Query from the Import External Data menu. Excel will then walk you 
through the process of choosing a URL and selecting the information you 
want to import. 

How do I manage long text entries?  
Many times, you want to enter simple text information in cell, but other 
times, you want to include a good amount of text information. By default, 
any text you enter will occur in one long line stretching across the following 
cells. If you use a lot of text, this can look messy. You can use ALT+Enter to 
insert a line break into your text, or you can turn on Excel’s word-wrapping 
feature by doing the following:  

• Select the cell with the text in it (or the cell that will have the text in 
it)  

• From the Format menu, click Cells…  

• Click the Alignment tab  

• Check the Wrap-text box  

• Click OK  
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